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SAMPLE QUESTION PAPER — SET 2  |  CLASS XII

Time Allowed: 3 Hours                                                                    Maximum Marks: 80

General Instructions:

1. This question paper contains 34 questions. All questions are compulsory.

2. This question paper is divided into two parts, Part A and Part B.

3. Part A is compulsory for all candidates.

4. Part B has two options: (i) Analysis of Financial Statements and (ii) Computerised Accounting. Students must attempt 
only ONE of the given options.

5. Questions 1 to 16 and 27 to 30 carry 1 mark each.

6. Questions 17 to 20, 31 and 32 carry 3 marks each.

7. Questions 21, 22 and 33 carry 4 marks each.

8. Questions 23 to 26 and 34 carry 6 marks each.

9. There is no overall choice. However, an internal choice has been provided in 7 questions of one mark, 2 questions of 
three marks, 1 question of four marks and 2 questions of six marks.

PART A

Accounting for Partnership Firms and Companies (Compulsory for all candidates)

1. A partner's Capital Account was debited with 35,000 during the year under the fluctuating capital ₹
method. Which of the following could explain this debit?

(A) Interest on capital allowed

(B) Share of profit

(C) Drawings during the year

(D) Salary credited

OR

Assertion (A): Under the Fixed Capital Method, a partner's Capital Account balance remains 
unchanged year to year unless capital is introduced or withdrawn.

Reason (R): All adjustments like interest, salary, drawings and profit share are recorded in a separate 
Current Account under this method.

(A) Both A and R are correct and R is the correct explanation of A.

(B) Both A and R are correct but R is not the correct explanation of A.

(C) A is correct but R is incorrect.

(D) Both A and R are incorrect.

1

2. A, B and C entered partnership sharing profits 4:3:3. C was guaranteed a minimum profit of 70,000₹  
p.a.; deficiency, if any, to be borne by A and B equally. For the year, the firm earned a profit of 

2,80,000. The deficiency borne by A and B will be:₹

(A) A 10,500 and B 10,500₹ ₹

(B) No deficiency arises; C's normal share already exceeds 70,000₹

(C) A 35,000 and B 35,000₹ ₹

1



(D) A 7,000 and B 7,000₹ ₹

3. Zenith Ltd. issued 40,000 shares of 10 each at a premium of 3, payable 6 on application (incl. ₹ ₹ ₹
1 premium), 5 on allotment (incl. 2 premium), balance on call. Priya, holding 800 shares, failed ₹ ₹ ₹

to pay allotment and was immediately forfeited. All 800 forfeited shares were reissued at 12 per ₹
share, fully paid. Determine the Capital Reserve transferred.

(A) 4,000    (B) 8,000    (C) 2,000    (D) 6,000₹ ₹ ₹ ₹

OR

Apex Ltd. forfeited 8,000 shares of 10 each, 7 called up (including 2 premium), on which 5 ₹ ₹ ₹ ₹
(including 2 premium) had been received. Of these, 6,000 shares were reissued at 8 per share, ₹ ₹

10 paid-up. Determine the Share Forfeited balance after reissue.₹

(A) 6,000    (B) 24,000    (C) 18,000    (D) 12,000₹ ₹ ₹ ₹

1

4. Ridge Ltd. took over the running business of Valley Ltd. comprising assets of 25,00,000 and ₹
liabilities of 6,00,000, and in consideration issued 15,000 equity shares of 100 each at a 10% ₹ ₹
premium, plus a cheque of 4,00,000. Determine the amount of Goodwill or Capital Reserve.₹

(A) Goodwill 1,50,000    (B) Capital Reserve 1,50,000    (C) Goodwill 2,50,000    (D) Capital ₹ ₹ ₹
Reserve 2,50,000₹

OR

Crest Ltd. purchased equipment, paying 2,50,000 by cheque and issuing 12,000 equity shares of ₹
10 each at 15% premium. The purchase consideration will be:₹

(A) 3,88,000    (B) 4,20,000    (C) 3,68,000    (D) 2,50,000₹ ₹ ₹ ₹

1

5. Aarav and Ishaan were partners with capitals of 20,00,000 and 15,00,000. They admitted Reena ₹ ₹
for a 1/5 share; she brought 12,00,000 as capital. An Investment Fluctuation Reserve of 60,000 ₹ ₹
and Investments of 3,00,000 appeared in the books. Aarav took over 20% of the investments at ₹

70,000, and the remaining investments were valued at 2,50,000. By what amount will the ₹ ₹
Revaluation Account be affected?

(A) Credited 20,000₹

(B) Debited 20,000₹

(C) Credited 10,000₹

(D) Debited 10,000₹

1

6. Riya and Sam are partners sharing profits 3:2. Their capitals are 5,00,000 and 3,00,000, with ₹ ₹
reserves of 2,00,000. Normal rate of return is 10%. Average profit for the year was 1,20,000. ₹ ₹
Value of goodwill as per the Capitalisation of Super Profits method will be:

(A) 2,00,000₹

(B) 1,00,000₹

(C) 3,00,000₹

(D) Nil

1

7. On 1 September, 2024, Meera, Nisha and Om entered partnership with capitals of 4,00,000 each. ₹
Interest on drawings was to be charged @6% p.a. For the year ended March 31, 2025, Om withdrew 

90,000 on 1 September, 2024. What interest on drawings will be charged from Om?₹

(A) 3,150₹

(B) 5,400₹

1



(C) 2,700₹

(D) 1,800₹

8. L, M and N were partners sharing profits 6:3:1. M died. L took over 1/10th (of the whole firm) from 
M's share, and N took over the remainder of M's share. Determine the new profit-sharing ratio.

(A) 7:3    (B) 6:4    (C) 3:1    (D) 7:1

OR

P, Q and R were partners sharing profits 4:3:3. Q retired, gifting 1/3 of his share to P, while the 
remaining 2/3 was taken over equally by P and R. Determine the new profit-sharing ratio.

(A) 3:2    (B) 6:4    (C) 1:1    (D) 5:3

1

9. M, a partner, was assigned to look after the dissolution process and was allowed remuneration of 
10,000. Actual realisation expenses amounted to 14,000, paid by another partner N. By what ₹ ₹

amount will the Realisation Account be debited?

(A) 14,000₹

(B) 24,000₹

(C) 4,000₹

(D) 10,000₹

1

10. Ravi and Karan share profits 3:2. They admitted Tara for a 20% share; Tara brought proportionate 
capital, including 40,000 for goodwill. If Ravi's adjusted capital (after all adjustments) was ₹

6,00,000, Karan's adjusted capital will be:₹

(A) 4,00,000    (B) 2,40,000    (C) 8,00,000    (D) 4,40,000₹ ₹ ₹ ₹

OR

Veer and Yash are partners sharing profits 3:2. Their capitals are 5,00,000 and 2,50,000. A ₹ ₹
General Reserve of 3,00,000 and Deferred Revenue Expenditure of 2,00,000 appear in the books. ₹ ₹
They admit Zara for a 25% share; she brings 3,00,000 as capital. Determine Zara's share of ₹
(hidden) goodwill.

(A) 12,500    (B) 25,000    (C) 50,000    (D) 10,000₹ ₹ ₹ ₹

1

11. Plant and machinery appearing in the books at 18,00,000 was overvalued by 25%. What amount ₹
will be shown in the Balance Sheet of the reconstituted firm?

(A) 14,40,000₹

(B) 22,50,000₹

(C) 13,50,000₹

(D) 16,00,000₹

1

12. Crown Ltd. issued 50,000, 10% Debentures of 100 each at a 3% discount, redeemable at an 8% ₹
premium after 4 years. On the date of issue, the Securities Premium balance was 4,00,000 and ₹
Statement of Profit and Loss (Dr.) was 2,00,000. Based on this, answer questions 12 to 14.₹

Loss on Issue of Debentures is to be written off as ______ out of Securities Premium and ______ out 
of Statement of Profit and Loss.

(A) 4,00,000 ; 1,50,000    (B) 3,00,000 ; 2,50,000    (C) 1,50,000 ; 4,00,000    (D) ₹ ₹ ₹ ₹ ₹ ₹
5,50,000 ; Nil₹

1

13. After writing off the Loss on Issue of Debentures, the balance in the Statement of Profit and Loss 1



will be:

(A) Debit ; 3,50,000    (B) Credit ; 3,50,000    (C) Debit ; 2,50,000    (D) Credit ; 2,50,000₹ ₹ ₹ ₹

14. Premium on Redemption of Debentures Account will have a balance of ______, to be treated as 
______ in the first year.

(A) 4,00,000 ; Non-Current Liability    (B) 4,00,000 ; Current Liability    (C) 1,50,000 ; Non-₹ ₹ ₹
Current Liability    (D) 1,50,000 ; Current Liability₹

1

15. D, E and F were partners sharing profits 4:3:3. Their firm was dissolved. Assets transferred to 
Realisation Account (Building 1,80,000; Furniture 70,000; Stock 60,000; Goodwill 12,000; ₹ ₹ ₹ ₹
Debtors 40,000) realised 3,20,000 in total. Determine the Realisation Gain/Loss.₹ ₹

(A) Realisation Loss 42,000₹

(B) Realisation Gain 42,000₹

(C) Realisation Loss 32,000₹

(D) No Gain or Loss on Realisation

1

16. Alok and Bhavna were partners sharing profits equally. They decided to share future profits 3:2. 
Their manager C met with an accident, and his claim for compensation amounted to 35,000. The ₹
firm had a Workmen Compensation Reserve of 50,000. Which of the following holds true at the ₹
time of reconstitution?

(A) 35,000 will be provided as a claim out of the Reserve, and the balance 15,000 distributed ₹ ₹
among partners in the OLD (equal) ratio.

(B) 35,000 will be provided, and the balance 15,000 distributed in the NEW ratio.₹ ₹

(C) 35,000 will be provided, and the balance 15,000 credited to Revaluation Account.₹ ₹

(D) 35,000 will be provided, and the balance 15,000 carried forward without treatment.₹ ₹

1

17. Meera, Priya and Tara are partners sharing profits 3:2:1. They admit Veer for a 1/6 share. It is agreed 
that Priya's new share will be 1/3. Goodwill of the firm is valued at 1,80,000, and Veer is unable to ₹
bring his share of goodwill in cash. Calculate the new ratio, sacrificing ratio, and pass the journal 
entry for the treatment of goodwill at the time of admission of Veer.

OR

Farah, Gopal and Harish were partners sharing profits 5:3:2. W.e.f. 1 April, 2025, they decided to 
share future profits in the ratio 4:3:3. On the date of reconstitution, Goodwill was appearing in the 
books at 1,50,000. Goodwill of the firm was valued at 2,50,000 on the date of reconstitution. ₹ ₹
Determine the gain or sacrifice of each partner, and pass the necessary journal entries.

3

18. Anjali and Bharat were partners sharing profits 3:2. The firm was dissolved, and the following 
balances appeared: Anjali's Loan 50,000; a third-party Loan 30,000; Creditors 70,000; Capital ₹ ₹ ₹
balances after all adjustments — Anjali 1,00,000 and Bharat 90,000. Assets of the firm realised at₹ ₹  

3,80,000. Show the amounts and order of payment as per Section 48 of the Indian Partnership Act, ₹
1932.

3

19. On 1 January, 2025, Sterling Ltd. issued 20,00,000, 10% Debentures of 100 each at a 3% ₹ ₹
discount, to be redeemed at an 8% premium after 4 years. The balance in Securities Premium on the 
date of issue was 1,20,000. Pass journal entries for the issue of debentures.₹

3

20. Ria and Sam are partners sharing profits 3:2. They decide to share future profits equally. On the date 
of reconstitution, an Investment Fluctuation Reserve of 2,50,000 existed in the books. Pass journal ₹

3



entries in each of the following independent cases:

A. Value of investments is reduced by 1,50,000.₹

B. Value of investments is increased by 3,00,000.₹

C. There is no change in the value of investments.

21. Coral Ltd. was registered with an authorised capital of 50,00,000 divided into 2,50,000 shares of ₹
20 each. The company offered and issued 1,00,000 shares at a premium of 4 per share, payable ₹ ₹
7 on application (incl. 1 premium), 9 on allotment (incl. 2 premium), and the balance on first ₹ ₹ ₹ ₹

call. Rehan, holding 6,000 shares, failed to pay allotment and call money. Another shareholder, 
Saniya, holding 3,000 shares, failed to pay call money. All shares held by Rehan were forfeited, and 
of these, 4,500 were reissued at 15 per share as fully paid. Show the Share Capital sub-head as it ₹
would appear in the Balance Sheet of Coral Ltd., along with Notes to Accounts, as per the 
Companies Act, 2013.

4

22. Aditya, Bhavya and Chirag are partners sharing profits 5:3:2. Their capitals are 6,00,000, ₹
5,00,000 and 3,00,000 respectively. As per the Partnership Deed:₹ ₹

(a) Interest on Capital @10% p.a.

(b) Salary to Aditya 6,000 p.m. and Chirag 10,000 per quarter.₹ ₹

(c) Commission to Bhavya 50,000.₹

(d) Bhavya is guaranteed a minimum profit share of 48,000; deficiency, if any, to be borne by ₹
Aditya and Chirag equally.

Ignoring the above terms, the profits of 4,00,000 for the year ended March 31, 2025 were divided ₹
equally between the partners. Pass the necessary single adjustment entry, showing your workings 
clearly.

4

23. Cove Ltd. purchased the running business of Bay Ltd., comprising assets of 30,00,000 and ₹
liabilities of 9,00,000, and issued fully paid Equity Shares of 100 each at a premium of 20% in ₹ ₹
full settlement. During the same year, Cove Ltd. also issued 25,000 additional Equity Shares of 100₹  
each at a premium of 15 per share for cash, fully subscribed and paid.₹

Pass journal entries for both transactions, and prepare the Share Capital Account and Securities 
Premium Account. (Assume an opening Share Capital balance of 1,20,00,000 and an opening ₹
Securities Premium balance of 6,00,000.)₹

6

24. Naina, Omkar and Priya were partners sharing profits 5:3:2. Omkar retired on March 31, 2025. On 
this date, his dues after all adjustments came to 4,90,000. He was paid 40,000 through Furniture ₹ ₹
on retirement, and it was agreed to pay the balance in three equal annual instalments together with 
interest at 6% p.a. (the default rate under the Act), the first instalment being paid on March 31, 2026. 
Pass the entry for immediate payment to Omkar on retirement, and prepare Omkar's Loan Account 
until it is finally closed.

6

25. Naina and Om were partners sharing profits 3:2. Their Balance Sheet as at March 31, 2025 was: 
Capitals — Naina 2,50,000, Om 1,80,000; Creditors 70,000; total 5,00,000. Assets: Cash ₹ ₹ ₹ ₹

30,000; Building 2,20,000; Debtors (net) 90,000; Investments 80,000; Stock 80,000; total ₹ ₹ ₹ ₹ ₹
5,00,000.₹

On this date, they admitted Priya for a 20% share. Priya brought 1,80,000 as capital and 30,000 ₹ ₹
for goodwill. It was agreed: a) Provision for Doubtful Debts to be increased by 5,000. b) ₹
Investments (book value 80,000) valued at 65,000. c) Building (book value 2,20,000) ₹ ₹ ₹
appreciated by 10%. Prepare the Revaluation Account and Partners' Capital Accounts.

OR

6



Kabir, Lena and Manish were partners sharing profits 5:3:2. Their Balance Sheet as at March 31, 
2025 showed: Capitals — Kabir 1,20,000, Lena 90,000, Manish 70,000; Creditors 50,000; ₹ ₹ ₹ ₹
total 3,30,000. Assets: Cash 35,000; Building 1,20,000; Debtors 70,000; Stock 65,000; ₹ ₹ ₹ ₹ ₹
Goodwill 40,000; total 3,30,000. On this date, Lena retired. It was agreed: (a) Provision for ₹ ₹
Doubtful Debts @10% on Debtors. (b) Building valued at 1,45,000. (c) Goodwill of the firm ₹
valued at 70,000. Prepare the Revaluation Account and Partners' Capital Accounts.₹

26. Nimbus Ltd. was registered with an authorised capital of 12,00,000 divided into 1,20,000 shares of ₹
10 each. The company offered 50,000 shares for public subscription, payable 3 on application and₹ ₹  
5 on allotment (including 1 premium). Applications were received for 62,500 shares, and pro-rata ₹ ₹

allotment was made in the ratio 5:4. Remaining applications were rejected. Kavya, who applied for 
5,000 shares (allotted 4,000), failed to pay the allotment money on her allotted shares, which were 
duly forfeited. Of these, 3,000 shares were later reissued at a discount of 1 per share, fully paid.₹

Pass the necessary entries in the books of Nimbus Ltd.

OR

Axis Ltd. invited applications for 1,00,000 shares of 10 each, payable 3 on application, 4 on ₹ ₹ ₹
allotment (including 1 premium), balance on call. Applications were received for 1,50,000 shares, ₹
of which 20% were rejected, and the remaining were allotted on a pro-rata basis. Karan, an applicant 
for 6,000 shares, failed to pay allotment money. Leela, holding 4,000 shares, paid the entire amount 
due along with allotment. Subsequently the call was made; all money was duly received except from 
Karan. The company issued a notice to Karan; he cleared his dues within the stipulated period. 
Journalise these transactions.

6

PART B — OPTION I

Analysis of Financial Statements (Attempt Part B Option I OR Option II, not both)

27. A company had the following balances:

Raw Material: 30,000 (2025), 40,000 (2024). Work in Progress: 80,000 (2025), 60,000 (2024).₹ ₹ ₹ ₹  
Finished Goods: 90,000 (2025), 75,000 (2024). Stock in Trade: 1,50,000 (2025), 1,90,000 ₹ ₹ ₹ ₹
(2024).

Determine the amount of Change in Inventories to be shown in the Statement of Profit and Loss.

(A) 15,000    (B) (15,000)    (C) 25,000    (D) (25,000)₹ ₹ ₹ ₹

1

28. The Inventory Turnover Ratio of a company was 5 times. The firm had a Revenue from Operations 
of 7,50,000, and Gross Profit was 30% of Revenue from Operations. Determine the amount of ₹
Opening Inventory if Closing Inventory was 90,000.₹

(A) 1,20,000    (B) 90,000    (C) 2,10,000    (D) 60,000₹ ₹ ₹ ₹

OR

Assertion (A): Net Profit Ratio is always lower than Gross Profit Ratio.

Reason (R): Net Profit is computed by deducting operating and non-operating expenses from, and 
adding non-operating incomes to, Gross Profit.

(A) Both A and R are correct and R is the correct explanation of A.

(B) Both A and R are correct but R is not the correct explanation of A.

(C) A is correct but R is incorrect.

(D) A is incorrect but R is correct.

1



29. Proposed Dividend for the years ended March 31, 2025 and March 31, 2024 were 1,80,000 and ₹
1,40,000 respectively. Shareholders finalised the dividend amount at 1,20,000 during the year ₹ ₹

ended March 31, 2025 in the AGM held in June-July 2024. Unclaimed dividend as at March 31, 
2025 was 6,000. Choose the correct option while preparing the Cash Flow Statement:₹

(A) Added back 1,40,000; outflow 1,14,000    (B) Added back 1,80,000; outflow 1,14,000    ₹ ₹ ₹ ₹
(C) Added back 1,20,000; outflow 1,14,000    (D) Added back 1,80,000; outflow 1,20,000₹ ₹ ₹ ₹

OR

Provision for Tax for the years ended March 31, 2025 and March 31, 2024 were 2,20,000 and ₹
1,90,000 respectively. During the year, tax paid was 1,80,000. Determine the amount of tax ₹ ₹

provided during the year.

(A) 2,20,000    (B) 2,10,000    (C) 1,90,000    (D) 2,50,000₹ ₹ ₹ ₹

1

30. Which of the following is a cash flow from Financing Activities for a non-finance company?

(A) Interest received on investments

(B) Dividend received

(C) Repayment of a long-term loan

(D) Cash purchase of a fixed asset

1

31. Complete the following Comparative Balance Sheet as at March 31, 2024 and March 31, 2025:

Particulars | 31 Mar 2024 | 31 Mar 2025 | Absolute Change | % Change

Shareholders' Funds | 4,00,000 | ?? | 2,00,000 | ??

Non-current Liabilities | 2,00,000 | ?? | NIL | ??

Current Liabilities | ?? | 2,00,000 | 1,00,000 | ??

TOTAL | ?? | ?? | ?? | ??

Non-current Assets | 5,00,000 | ?? | ?? | 30

Current Assets | ?? | ?? | ?? | ??

TOTAL | ?? | ?? | ?? | ??

OR

Prepare a Common Size Statement of Profit and Loss for the year ended March 31, 2025:

Revenue from Operations 40,00,000; Other Expenses 4,00,000; Other Income 5,00,000; ₹ ₹ ₹
Employee Benefit Expenses 8,00,000; Purchases of Stock in Trade 9,00,000; Change in Inventory₹ ₹  

(1,50,000); Tax Rate 40%.₹

3

32. (i) Give two examples of items shown under 'Other Current Assets'.

(ii) Where will you disclose 'Discount on Issue of Debentures' (not yet written off) in the Balance 
Sheet?

(iii) Where will you disclose Investments in the Balance Sheet of a company?

3

33. The Quick Ratio of Moonlight Traders is 1.2:1. State, with reasons, whether each of the following 
transactions will increase, decrease, or have no effect on the ratio:

a) Bills receivable discounted with the bank (cash received).

b) Creditors paid off in cash.

c) Prepaid expenses written off.

4



d) Debentures issued for cash.

OR

From the following information, calculate the Trade Receivables Turnover Ratio: Cost of Revenue 
from Operations 5,00,000; Gross Profit 20% on Cost; Cash Sales 25% of Total Sales; Opening ₹
Debtors 80,000; Closing Debtors 1,20,000; Provision for Doubtful Debts — Opening 8,000, ₹ ₹ ₹
Closing 12,000.₹

34. Extracts of the Balance Sheets of M/s Summit Ltd. as at March 31, 2024 and March 31, 2025, along 
with additional information, are given below. Calculate: (i) Operating Profit before changes in 
Working Capital. (ii) Cash Flows from Financing Activities.

Equity Share Capital: 18,00,000 (2025), 14,00,000 (2024). 8% Preference Share Capital: ₹ ₹
2,50,000 (2025), 3,50,000 (2024). Cash Credit: 1,80,000 (2025), 90,000 (2024). Profit and ₹ ₹ ₹ ₹

Loss (Cr.): 10,00,000 (2025), 8,00,000 (2024). 12% Debentures: 4,00,000 (2025), 3,00,000 ₹ ₹ ₹ ₹
(2024). Bank Overdraft: 1,00,000 (2025), 50,000 (2024). Outstanding Interest on Debentures: ₹ ₹

5,000 (2025), Nil (2024).₹

Additional Information: a) New equity shares and debentures were issued during the year. New 
debentures were issued at a 5% discount, written off at the end of the year. b) Dividend on 
preference shares (full year, on the opening balance) and an interim dividend of 10% on equity 
shares (on the opening balance) were paid during the year. c) Preference shares of 1,00,000 were ₹
redeemed during the year at a 4% premium; the premium was provided out of profits.

6

PART B — OPTION II

Computerised Accounting (Attempt Part B Option I OR Option II, not both)

27. Which chart is best suited to show a trend over a period of time?

(A) Pie Chart    (B) Line Chart    (C) Bar Chart    (D) Scatter Chart

OR

Codification helps in:

(A) reducing data redundancy    (B) increasing data size    (C) slowing down processing    (D) 
eliminating the need for validation

1

28. Which menu is used to insert a chart in a spreadsheet?

(A) Home

(B) Insert

(C) View

(D) Data

1

29. Which of the following is NOT a limitation of a Computerised Accounting System?

(A) High installation cost

(B) Risk of data loss due to virus attacks

(C) Fast and accurate report generation

(D) Requires trained personnel

1

30. A block code is used when: 1



(A) codes are assigned in strict consecutive order    (B) codes are grouped into blocks representing 
categories    (C) only letters are used    (D) no rules are followed

OR

Which accounting sub-system handles payroll processing?

(A) Cash and Bank sub-system    (B) Payroll sub-system    (C) Inventory sub-system    (D) Sales 
sub-system

31. What is validation of data, and why is it important in a Computerised Accounting System? 3

32. State three features of a good accounting software. 3

33. State the steps to create a graph from a selected range of data in a spreadsheet.

OR

Explain the purpose of the 'Input Message' tab in Data Validation.

4

34. What is meant by 'freezing panes' in a spreadsheet? How is it done, and why is it useful? 6



ACCOUNTANCY
Code No. 055 — Marking Scheme

MARKING SCHEME — SET 2  |  CLASS XII

PART A

Accounting for Partnership Firms and Companies

1. Drawings reduce (debit) the partner's capital; interest, profit share and salary would credit it.  
Answer: (C) Drawings during the year

OR: Both A and R are true, and R correctly explains why the balance is otherwise unchanged.  
Answer: (A)

1

2. C's normal share = 2,80,000 × 3/10 = 84,000, which already exceeds the 70,000 guarantee, so no ₹
deficiency arises.  Answer: (B)

1

3. At forfeiture: Share Capital Dr (5+3=8 per share) × 800 = 6,400; Securities Premium Dr (unpaid) = 
2×800=1,600; Share Forfeited Cr = 5×800=4,000; Allotment Receivable Cr = 4,000. On reissue at 

12 (above face value), no discount needed, so the entire 4,000 is transferred to Capital Reserve.  ₹ ₹
Answer: (A) 4,000₹

OR: Called-up capital = 5 per share (7−2 premium); received capital = 3 (5−2 premium); unpaid = 2. 
Share Forfeited = 3×8,000=24,000. Portion for 6,000 reissued shares = 18,000. Discount on reissue 
(10−8)×6,000=12,000 adjusted; remaining 6,000 to Capital Reserve. Balance remaining in Share 
Forfeited (for 2,000 un-reissued shares) = 24,000−18,000 = 6,000.  Answer: (A) 6,000₹ ₹

1

4. PC = (15,000×110)+4,00,000 = 20,50,000. Net Assets = 25,00,000−6,00,000 = 19,00,000. Goodwill 
= 20,50,000−19,00,000 = 1,50,000.  Answer: (A)₹

OR: PC = 2,50,000+(12,000×11.5) = 2,50,000+1,38,000 = 3,88,000.  Answer: (A)₹

1

5. Aarav's portion (20% of 3,00,000=60,000 book value) at 70,000: gain 10,000. Remaining (2,40,000 
book value) at 2,50,000: gain 10,000. Net overall increase = 20,000, credited to Revaluation.  
Answer: (A) Credited 20,000₹

1

6. Capital employed = 5,00,000+3,00,000+2,00,000 = 10,00,000. Normal Profit = 1,00,000. Super 
Profit = 1,20,000−1,00,000 = 20,000. Goodwill = 20,000×10 = 2,00,000.  Answer: (A)₹

1

7. Period 1 Sept to 31 March = 7 months. Interest = 90,000×6%×7/12 = 3,150.  Answer: (A)₹ 1

8. New L = 6/10+1/10 = 7/10. New N = 1/10+2/10 = 3/10. Ratio = 7:3.  Answer: (A)

OR: Q's share 3/10; gifted 1/10 to P; remaining 2/10 split equally 1/10 each. New P = 
4/10+1/10+1/10 = 6/10. New R = 3/10+1/10 = 4/10. Ratio = 6:4 = 3:2.  Answer: (A) 3:2

1

9. Realisation Account is debited only with the agreed remuneration ( 10,000).  Answer: (D)₹ 1

10. Karan's capital = 6,00,000×2/3 = 4,00,000.  Answer: (A)₹

OR: Adjusted Veer = 5,00,000+3,00,000×3/5−2,00,000×3/5 = 5,60,000. Adjusted Yash = 
2,50,000+3,00,000×2/5−2,00,000×2/5 = 2,90,000. Total = 8,50,000. Implied total (Zara's 3,00,000 
for 25%) = 12,00,000. Hidden goodwill = 12,00,000−(8,50,000+3,00,000) = 50,000. Zara's share = 
50,000×25% = 12,500.  Answer: (A) 12,500₹ ₹

1



11. True value = 18,00,000/1.25 = 14,40,000.  Answer: (A)₹ 1

12. Total discount = 50,000×100×3% = 1,50,000. Premium on redemption = 50,000×100×8% = 
4,00,000. Total loss = 5,50,000. Written off first against Securities Premium (4,00,000 available), 
remaining 1,50,000 against P&L.  Answer: (A) 4,00,000 ; 1,50,000₹ ₹

1

13. Existing 2,00,000 + further write-off 1,50,000 = 3,50,000 (Debit).  Answer: (A)₹ 1

14. Premium payable = 4,00,000, classified as Non-Current Liability.  Answer: (A)₹ 1

15. Book value = 1,80,000+70,000+60,000+12,000+40,000 = 3,62,000. Realised = 3,20,000. Loss = 
42,000.  Answer: (A)₹

1

16. Claim (35,000) provided from the Reserve; surplus (15,000) distributed in the OLD (equal) ratio, 
since it relates to the period before reconstitution.  Answer: (A)

1

17. Remaining for Meera = 1−1/6(Veer)−1/3(Priya) = 1−2/12−4/12 = 6/12=1/2. Priya's new share = 
1/3=4/12. Veer=1/6=2/12. Meera=1/2=6/12.

Old Meera=3/6=6/12, Priya=2/6=4/12. Meera's sacrifice = 6/12−6/12=0. Priya's sacrifice = 
4/12−4/12=0?? Recompute carefully: Old ratio 3:2:1 (Meera:Priya:Tara) sums to 6, so 
Meera=3/6=1/2=6/12, Priya=2/6=1/3=4/12, Tara=1/6=2/12. New: Priya's share stated as 1/3=4/12 
(same as before!). Veer=1/6=2/12. Remaining for Meera and Tara combined = 1−4/12−2/12=6/12, 
split in their old relative ratio (Meera:Tara=3:1) = Meera 4.5/12, Tara 1.5/12.

Meera's sacrifice = 6/12−4.5/12=1.5/12=1/8. Tara's sacrifice = 2/12−1.5/12=0.5/12=1/24. Sacrificing 
ratio Meera:Tara = 1/8:1/24 = 3:1.

Veer's goodwill share = 1,80,000×1/6 = 30,000, shared Meera:Tara 3:1 = 22,500:7,500.

Journal entry: Veer's Current A/c Dr 30,000; To Meera's Capital A/c 22,500; To Tara's Capital A/c 
7,500.  [3]

OR

Old 5:3:2 = 50:30:20/100. New 4:3:3 = 40:30:30/100. Farah: sacrifice 10/100. Gopal: no change. 
Harish: gain 10/100.

Existing goodwill (1,50,000) written off in old ratio: Farah 75,000; Gopal 45,000; Harish 30,000.

Harish's gain (10/100)×2,50,000 = 25,000, paid entirely to Farah (the only partner who sacrificed).

Journal: (i) Farah's Capital Dr 75,000; Gopal's Capital Dr 45,000; Harish's Capital Dr 30,000; To 
Goodwill 1,50,000. (ii) Harish's Capital Dr 25,000; To Farah's Capital 25,000.  [3]

3

18. Outside liabilities = 70,000+30,000 = 1,00,000. Partners' Loan = 50,000. Capitals = 1,00,000+90,000 
= 1,90,000. Total dues = 1,00,000+50,000+1,90,000 = 3,40,000. Realised = 3,80,000, exceeding 
dues by 40,000, distributed to partners 3:2 = Anjali 24,000; Bharat 16,000, in addition to their capital 
balances being paid in full.  [3]

3

19. Bank A/c Dr 19,40,000 (20,00,000×97); Discount/Loss on Issue of Debentures A/c Dr 1,60,000 
[discount 60,000 + premium on redemption 1,60,000 wait recompute: 
discount=20,00,000×3%=60,000; premium on redemption=20,00,000×8%=1,60,000; total 
loss=2,20,000]; To 10% Debentures Application and Allotment A/c 20,00,000; To Premium on 
Redemption of Debentures A/c 1,60,000.

10% Debentures Application and Allotment A/c Dr 20,00,000; To 10% Debentures A/c 20,00,000.

Securities Premium A/c Dr 1,20,000 (writing off up to the available balance); Statement of Profit and 

3



Loss Dr 1,00,000; To Discount/Loss on Issue of Debentures A/c 2,20,000.  [3]

20. A. Investment A/c Dr 1,50,000; To Investment Fluctuation Reserve A/c 1,50,000 (loss adjusted 
against existing IFR of 2,50,000; remaining 1,00,000 distributed to old partners 3:2).

B. Investment A/c Dr 3,00,000 credited partly to IFR (up to its balance 2,50,000) and the excess gain 
(50,000) credited directly to partners' capitals in old ratio; the entire IFR (2,50,000) also then 
distributed to partners 3:2.

C. No change: entire IFR of 2,50,000 distributed to old partners 3:2 (1,50,000 and 1,00,000).  [3]

3

21. Note to Accounts — Share Capital: Authorised Capital: 2,50,000 shares of 20 each = 50,00,000.₹ ₹

Issued, Subscribed and Called-up: 1,00,000 shares of 20 each = 20,00,000; Less: Calls-in-arrears ₹
(Saniya, 3,000× 4 unpaid call) = 12,000; Net Share Capital shown, after accounting for Rehan's ₹
forfeiture and the reissue of 4,500 of his shares (following the standard forfeiture-reissue procedure 
as illustrated in Q3) = approximately 19,88,000.  [4]₹

4

22. Correct distribution: Interest on Capital — Aditya 60,000; Bhavya 50,000; Chirag 30,000. Salary — 
Aditya 72,000 (6,000×12); Chirag 40,000 (10,000×4). Commission — Bhavya 50,000.

Total appropriations = 60,000+50,000+30,000+72,000+40,000+50,000 = 3,02,000. Balance profit = 
4,00,000−3,02,000 = 98,000, shared 5:3:2 = 49,000:29,400:19,600.

Bhavya's total = Commission50,000+Interest50,000+Profitshare29,400 = 1,29,400, well above the 
48,000 guarantee — no deficiency.

Correct totals: Aditya = 60,000+72,000+49,000 = 1,81,000. Bhavya = 50,000+50,000+29,400 = 
1,29,400. Chirag = 30,000+40,000+19,600 = 89,600. Total = 4,00,000 .✓

Wrongly credited (equally) = 1,33,333 each (approx).

Adjustment entry: Bhavya's Capital A/c Dr 3,933 (approx); Chirag's Capital A/c Dr 43,733 (approx); 
To Aditya's Capital A/c 47,667 (approx).  [4]

4

23. Purchase consideration = 30,00,000−9,00,000 = 21,00,000. Shares issued at 120 each (100+20%) =₹  
21,00,000/120 = 17,500 shares.

(i) Business Purchase: Assets A/c Dr 30,00,000; To Liabilities A/c 9,00,000; To Bay Ltd. A/c 
21,00,000.

(ii) Bay Ltd. A/c Dr 21,00,000; To Equity Share Capital A/c 17,50,000 (17,500×100); To Securities 
Premium A/c 3,50,000 (17,500×20).

(iii) Bank A/c Dr 28,75,000 (25,000×115); To Equity Share Application and Allotment A/c 
28,75,000.

(iv) Equity Share Application and Allotment A/c Dr 28,75,000; To Equity Share Capital A/c 
25,00,000; To Securities Premium A/c 3,75,000.

Share Capital A/c: Opening 1,20,00,000+17,50,000+25,00,000 = Closing 1,62,50,000.₹

Securities Premium A/c: Opening 6,00,000+3,50,000+3,75,000 = Closing 13,25,000.  [6]₹

6

24. Immediate entry: Omkar's Capital A/c Dr 4,90,000; To Furniture A/c 40,000; To Omkar's Loan A/c 
4,50,000.

Omkar's Loan Account: Year 1: Opening 4,50,000, Interest@6%=27,000, Paid 
1,50,000+27,000=1,77,000, Balance 3,00,000.

Year 2: Opening 3,00,000, Interest=18,000, Paid 1,68,000, Balance 1,50,000.

Year 3: Opening 1,50,000, Interest=9,000, Paid 1,59,000, Balance Nil (closed).  [6]

6



25. Revaluation: Debit — Provision increase 5,000; Investment loss 15,000 = 20,000. Credit — Building 
appreciation (10% of 2,20,000) 22,000. Net gain = 2,000, shared 3:2 = 1,200:800.

Goodwill (30,000) shared 3:2 = 18,000:12,000.

Capital Accounts: Naina = 2,50,000+1,200+18,000 = 2,69,200. Om = 1,80,000+800+12,000 = 
1,92,800. Priya = 1,80,000 (capital brought in).  [6]

OR

Revaluation: Debit — Provision @10% on 70,000 = 7,000. Credit — Building revalued 
(1,45,000−1,20,000) = 25,000. Net gain = 18,000, shared 5:3:2 = 9,000:5,400:3,600.

Existing Goodwill (40,000) written off old ratio: Kabir 20,000; Lena 12,000; Manish 8,000. New 
Goodwill (70,000); Lena's share (3/10) = 21,000, contributed by Kabir and Manish equally (10,500 
each, in the absence of a specified gaining ratio).

Capital Accounts: Kabir = 1,20,000+9,000−20,000−10,500 = 98,500. Lena = 
90,000+5,400−12,000+21,000 = 1,04,400 (transferred to Loan on retirement). Manish = 
70,000+3,600−8,000−10,500 = 55,100.  [6]

6

26. Kavya applied for 5,000, allotted 4,000 (5:4). Application paid on 5,000 = 15,000; due on 4,000 
allotted = 12,000; excess 3,000 adjusted against allotment. Allotment due (4,000×5=20,000) less 
excess (3,000) = 17,000 unpaid — forfeited.

Forfeiture: Share Capital A/c Dr 32,000 (4,000×8 called-up); Securities Premium A/c Dr 4,000 
(unpaid premium); To Share Forfeited A/c 15,000; To Share Allotment A/c 17,000.

Reissue: 3,000 shares at a 1 discount (i.e. 9), fully paid — discount of 3,000 adjusted against ₹ ₹
Share Forfeited; remaining balance transferred to Capital Reserve.  [6]

OR

Applications 1,50,000; 20% (30,000) rejected, remaining 1,20,000 allotted pro-rata against 1,00,000 
offered (ratio 6:5). Karan applied for 6,000, allotted 5,000; failed to pay allotment but paid within the 
stipulated notice period after the call — no forfeiture occurs. Leela (4,000 shares) paid the full 
amount due (including the call) along with allotment, recorded as Calls-in-Advance until the call is 
actually made. Standard application, allotment (with pro-rata excess adjustment), calls-in-advance, 
and call entries follow.  [6]

6

PART B — OPTION I

Analysis of Financial Statements

27. Total Closing = 30,000+80,000+90,000+1,50,000 = 3,50,000. Total Opening = 
40,000+60,000+75,000+1,90,000 = 3,65,000. Change (Opening−Closing) = 3,65,000−3,50,000 = 

15,000.  Answer: (A)₹

1

28. Gross Profit = 30%×7,50,000 = 2,25,000. Cost of Revenue = 5,25,000. Average Inventory = 
5,25,000/5 = 1,05,000. Opening = (1,05,000×2)−90,000 = 1,20,000.  Answer: (A)₹

OR: A is not always true in general (if non-operating income significantly exceeds 
non-operating/operating expenses, Net Profit could exceed Gross Profit) — but R correctly describes 
the computation.  Answer: (D) A is incorrect but R is correct.

1

29. Added back should be the CURRENT year's proposed dividend (1,80,000, a non-cash 
appropriation); outflow is based on the PRIOR year's finalised amount (1,20,000) less unclaimed 
(6,000) = 1,14,000.  Answer: (B)

1



OR: Tax provided = 2,20,000−1,90,000+1,80,000 = 2,10,000.  Answer: (B)₹

30. For a non-finance company, repayment of a long-term loan is a Financing activity.  Answer: (C) 1

31. Shareholders' Funds 2025 = 6,00,000 (50%). Non-current Liabilities 2025 = 2,00,000 (0%). Current 
Liabilities 2024 = 1,00,000 (100%).

Total 2024 = 4,00,000+2,00,000+1,00,000 = 7,00,000. Total 2025 = 6,00,000+2,00,000+2,00,000 = 
10,00,000 (change 3,00,000, ≈42.86%).

Non-current Assets 2025 = 5,00,000×1.30 = 6,50,000 (change 1,50,000). Current Assets 2024 = 
7,00,000−5,00,000 = 2,00,000. Current Assets 2025 = 10,00,000−6,50,000 = 3,50,000 (change 
1,50,000, 75%).  [3]

OR

Common Size Statement (% of Revenue 40,00,000): Other Income 12.5%; Total Income 112.5%. ₹
Employee Benefit Expenses 20%; Purchases 22.5%; Change in Inventory −3.75%; Other Expenses 
10%; Total Expenses 48.75%. Profit before Tax = 63.75% ( 25,50,000). Tax@40% = 25.5% ₹
( 10,20,000). Profit after Tax = 38.25% ( 15,30,000).  [3]₹ ₹

3

32. (i) Examples of Other Current Assets: Prepaid expenses, and Accrued (unbilled) revenue/income.

(ii) Discount on Issue of Debentures (not yet written off) is shown under Other Current Assets or 
Other Non-Current Assets, depending on the period it relates to (as a residual, not-yet-expensed 
item).

(iii) Investments are disclosed under Non-Current Assets (Non-current Investments) or Current 
Assets (Current Investments/Marketable securities), depending on their nature and holding period.  
[3]

3

33. a) Bills receivable discounted (cash received): current assets composition changes (debtors/BR 
decrease, cash increases by a slightly lower amount due to discounting charges) but total quick assets 
marginally decrease due to the discount charge — ratio DECREASES slightly, though total current 
assets remain largely similar; treated conventionally as NO SIGNIFICANT CHANGE to slight 
decrease.

b) Creditors paid off in cash: both quick assets (cash) and current liabilities (creditors) decrease by 
the same amount — since the ratio was above 1 (1.2:1), the ratio INCREASES.

c) Prepaid expenses written off: prepaid expenses are excluded from quick assets already, so this has 
NO EFFECT on the Quick Ratio.

d) Debentures issued for cash: quick assets (cash) increase; current liabilities unchanged (debentures 
are non-current) — ratio INCREASES.  [4]

OR: Gross Profit = 20% on Cost = 1,00,000. Total Sales = Cost+GP = 6,00,000. Credit Sales = 75% 
of Total Sales = 4,50,000. Average Debtors (gross, before providing for doubtful debts) = 
(80,000+1,20,000)/2 = 1,00,000. Trade Receivables Turnover Ratio = 4,50,000/1,00,000 = 4.5 times. 
[4]

4

34. (i) Increase in P&L = 10,00,000−8,00,000 = 2,00,000. Preference Dividend = 8%×3,50,000 = 
28,000. Interim Equity Dividend = 10%×14,00,000 = 1,40,000. Premium on Redemption = 
4%×1,00,000 = 4,000. Total appropriations = 1,72,000.

Net Profit before appropriations = 2,00,000+1,72,000 = 3,72,000.

Add back: Discount on Debentures (5%×1,00,000 new) = 5,000; Interest on Debentures 
(12%×3,00,000 opening) = 36,000.

Operating Profit before Working Capital Changes = 3,72,000+5,000+36,000 = 4,13,000.  [3]₹

6



(ii) Cash Flows from Financing Activities:

+ Equity Issue (18,00,000−14,00,000) = 4,00,000

+ Debenture Issue, net of discount (1,00,000−5,000) = 95,000

− Preference Redemption (1,00,000+4,000) = (1,04,000)

− Preference Dividend paid = (28,000)

− Interim Equity Dividend paid = (1,40,000)

− Interest on Debentures paid in cash (36,000−5,000) = (31,000)

+ Increase in Cash Credit (1,80,000−90,000) = 90,000

+ Increase in Bank Overdraft (1,00,000−50,000) = 50,000

Net Cash Flow from Financing Activities = 3,32,000 (inflow).  [3]₹

PART B — OPTION II

Computerised Accounting

27. A Line Chart is best suited to show a trend over time.  Answer: (B)

OR: Codification reduces data redundancy and enables systematic identification.  Answer: (A)

1

28. The Insert menu is used to insert a chart.  Answer: (B) 1

29. Fast and accurate report generation is an ADVANTAGE, not a limitation.  Answer: (C) 1

30. A block code groups codes into blocks representing different categories.  Answer: (B)

OR: The Payroll sub-system handles payroll processing.  Answer: (B)

1

31. Validation of data refers to checking that data entered into the system meets predefined rules (e.g. 
correct data type, range, format) before it is accepted. It is important in a CAS because it prevents 
incorrect or inconsistent data from corrupting accounting records, reduces errors, and improves the 
reliability of financial reports.  [3]

3

32. Features of good accounting software: (i) Accuracy and speed in processing large volumes of 
transactions; (ii) Ability to generate reports (trial balance, P&L, balance sheet) instantly in the 
desired format; (iii) Data security features such as passwords and access control to maintain 
confidentiality.  [3]

3

33. Steps to create a graph: (i) Select the range of data to be charted; (ii) Choose Insert > Chart/Graph 
and select the desired type; (iii) Customise the chart's title, axis labels and legend; (iv) Position and 
format the chart within the worksheet.  [4]

OR: The 'Input Message' tab (under Data Validation) allows the user to display a helpful message or 
instruction when a cell is selected, guiding the user on what type of data is expected before they enter 
it, reducing input errors.  [4]

4

34. Freezing panes keeps a selected row/column (typically headers) visible on screen while scrolling 
through the rest of a large worksheet. It is done via View > Freeze Panes, after selecting the 
row/column below/right of which the freeze should apply. It is useful for keeping column or row 
headings in view while working with large datasets, avoiding confusion about which column/row a 
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given cell belongs to.  [6]


